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Introduction to KiCad Version 9
KiCad è una suite software open source per la creazione di schemi di circuiti elettrici, circuiti stampati (PCB)
e descrizioni delle parti associate. KiCad supporta flussi di lavoro di progettazione integrati in cui uno
schema e un C.S, corrispondenti vengono progettati assieme, ma anche flussi di lavoro indipendenti per usi
speciali. KiCad include anche diverse utilità per aiutare nella progettazione di schemi e C.S., tra cui una

calcolatrice di C.S. per determinare le proprietà elettriche delle strutture dei circuiti, un visualizzatore file
Gerber per l’ispezione dei file di produzione, un visualizzatore 3D per visualizzare la scheda finita e un
simulatore SPICE integrato per il controllo del comportamento circuitale.

KiCad funziona su tutti i principali sistemi operativi e su un’ampia gamma di computer. Supporta circuiti

stampati con un massimo di 32 strati rame ed è adatto a creare progetti di ogni tipo di complessità. KiCad
viene sviluppato da un team di programmatori e progettisti elettronici volontari provenienti da tutto il
mondo con la missione di creare un programma di progettazione elettronica (CAD) gratuito e libero per la

progettazione professionale.

The latest documentation for KiCad is available at https://docs.kicad.org. This document applies to KiCad
version 9.0.

Scaricamento e installazione di KiCad
KiCad funziona su molti sistemi operativi, inclusi Microsoft Windows, Apple macOS e molte delle principali

distribuzioni Linux.

Per trovare istruzioni aggiornate e collegamenti per il download consultare l’indirizzo
https://www.kicad.org/download/. Queste istruzioni non sono incluse in questo manuale in quanto possono
cambiare nel tempo e con il rilascio degli aggiornamenti del sistema operativo.

IMPORTANT

I rilasci stabili di KiCad avvengono periodicamente secondo la https://dev-
docs.kicad.org/" "en/rules-guidelines/release-policy/[Politica dei rilasci stabili di KiCad].
Nuove funzioni vengono aggiunte continuamente al ramo di sviluppo. Se si vuole
sfruttare queste nuove caratteristiche e contemporaneamente aiutare a testarne lo
sviluppo, scaricare l’ultimo pacchetto "nightly build" ovvero sperimentale, per la
propria piattaforma. I pacchetti sperimentali possono presentare dei bachi tuttavia è
l’obiettivo del team di sviluppo di KiCad mantenere il ramo di sviluppo più utilizzabile
possibile anche durante lo sviluppo di nuove funzionalità.

Supporto
Se avete idee, commenti o domande o se vi serve solamente un aiuto:

Il forum ufficiale degli utenti KiCad è un ottimo sito per entrare in contatto con altri utenti KiCad ed
ottenere aiuto.

Unisciti alle nostre comunità su Discord o IRC per discutere in tempo reale con utenti e sviluppatori.

Esplora le risorse didattiche presenti sul sito di KiCad create dalla comunità.

https://docs.kicad.org/
https://www.kicad.org/download/
https://dev-docs.kicad.org/
https://forum.kicad.info/
https://www.kicad.org/community/chat/
https://www.kicad.org/help/learning-resources/
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Concetti di base e diagramma di flusso
Il flusso di lavoro tipico di KiCad consiste in due compiti principali: disegno di uno schema elettrico e
progettazione di un circuito stampato.

Lo schema elettrico è una rappresentazione simbolica del circuito: esso indica che componenti vengono
impiegati e quali sono le connessioni che vengono effettuate tra di essi. I simboli nello schema sono

rappresentazioni grafiche dei componenti elettronici presenti in esso, come lo zigzag per una resistenza o
un triangolo per un amplificatore operazionale. Lo schema contiene i simboli per ogni componente del
progetto, con i fili che collegano i piedini nei simboli. In genere lo schema elettrico viene creato per primo, in
seguito si dispone i componenti nel circuito stampato.
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La scheda è la realizzazione fisica dello schema, con le impronte dei componenti posizionate sulla scheda e
le tracce in rame che realizzano le connessioni descritte nello schema. Le impronte sono un insieme di aree

di rame che corrispondono ai pin su un componente fisico. Quando la scheda viene prodotta e assemblata, il
componente verrà saldato sulla sua impronta corrispondente sul circuito stampato.

KiCad ha finestre separate per disegnare lo schema ("Editor dello schema"), disporre la scheda ("Editor del
Circuito Stampato") e modificare simboli e impronte ("Editor dei simboli" e "Editor delle impronte"). KiCad
viene fornito con un’ampia libreria di simboli e impronte di alta qualità forniti all’utente, ma è anche
semplice creare nuovi simboli e impronte o modificare simboli e impronte esistenti.
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Infine, è importante capire che KiCad ha un flusso di lavoro basato sul progetto. Un progetto KiCad è una
cartella con un file di progetto, uno schema, un layout o disposizione del circuito stampato e,

facoltativamente, altri file associati come librerie di simboli e impronte, dati di simulazione, distinta di base
dei componenti, ecc. Molte impostazioni relative al progetto, comprese le netclass e le regole di
progettazione, vengono memorizzate a livello di progetto. L’apertura di una scheda al di fuori del progetto
associato può comportare la mancanza di informazioni di progettazione, quindi è meglio assicurarsi di

mantenere assieme tutti i file associati ad uno specifico progetto.
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Il flusso di progettazione di C.S.
In genere, lo schema elettrico viene disegnato per primo. Ciò significa aggiungere simboli allo schema e
tracciare le connessioni tra di loro. Potrebbe essere necessario creare simboli personalizzati se i simboli

appropriati non sono già disponibili. In questa fase vengono anche selezionate le impronte per ogni
componente, con impronte personalizzate create secondo necessità. Quando lo schema è completo e il
progetto ha superato un controllo delle regole elettriche (ERC), le informazioni sul progetto nello schema
vengono trasferite all’editor del circuito stampato e inizia la fase di layout.

The schematic describes which components are in the design and how they are connected; the board editor
uses this information to make layout easier and to prevent mismatches between the schematic and PCB. The
layout process requires careful placement of each footprint on the circuit board. After component
placement, copper tracks are drawn between components based on the connections in the schematic as well

as other electrical considerations, such as track resistance, controlled impedance requirements, crosstalk,
etc.

Spesso lo schema dovrà essere aggiornato dopo l’inizio della disposizione; le modifiche allo schema possono
essere facilmente riflesse nel progetto dello stampato. Spesso può accadere il contrario: qualsiasi modifica

progettuale apportata al layout fisico della scheda può essere rimandata indietro allo schema per mantenere
le due coerenti uno con l’altro.

Quando il layout della scheda è completo e la scheda ha superato il controllo regole elettriche (DRC),

vengono generati i file necessari per la fabbricazione in modo che la scheda possa essere prodotta dal
fabbricante di circuiti stampati.
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Tutorial parte 1: il progetto
La prima cosa da fare quando si inizia è creare un nuovo progetto. Aprendo KiCad si aprirà la finestra del
progetto. Fare clic su File → Nuovo progetto, individuare la posizione desiderata e assegnare un nome al
progetto, ad esempio per-iniziare . Assicurati che la casella di controllo Crea una nuova cartella per il
progetto sia selezionata, quindi fare clic su Salva. Questo creerà tuoi file di progetto in una nuova

sottocartella con lo stesso nome del progetto.

A sinistra, il riquadro File progetto elenca  i file nel nuovo progetto. C’è un file progetto con estensione
.kicad_pro , un file schema con estensione .kicad_sch  e un file circuito stampato con estensione
.kicad_pcb . Questi file condividono tutti lo stesso nome del progetto.

Potrebbe esserci anche una cartella -backups : KiCad creerà automaticamente il backup del progetto

quando si salva, e opzionalmente, a intervalli di tempo fissi. Le impostazioni di backup sono configurabili
andando su Preferenze → Preferenze…  → Comuni → Backup progetto.

NOTE L’apertura della finestra delle preferenze può far aprire la configurazione della tabella
delle librerie. Questa è descritta di seguito.

NOTE Su macOS, la finestra delle preferenze è nel menu KiCad, non nel menu delle Preferenze.
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A destra della finestra del progetto, ci sono dei pulsanti per avviare i vari strumenti forniti da KiCad. L’avvio
di questi strumenti aprirà automaticamente il file di progettazione associato (dello schema o del C.S.) dal
progetto corrente. Iniziare aprendo l’editor degli schemi elettrici.
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Tutorial parte 2: schemi elettrici
Impostazione tabella librerie dei simboli
La prima volta che si apre l’editor degli schemi, viene visualizzata una finestra di dialogo che chiede come
configurare la tabella della libreria dei simboli globale. La tabella delle librerie di simboli indica a KiCad
quali librerie di simboli utilizzare e dove si trovano. Se si ha installato le librerie predefinite con KiCad, cosa
consigliata, selezionare l’opzione predefinita: Copia la tabella librerie simbolo globale predefinita
(raccomandato).

Se KiCad non riesce a trovare le librerie nella posizione di installazione prevista, questa opzione verrà
disabilitata. In tal caso, si dovrebbe scegliere la seconda opzione, *Copia la tabella librerie simbolo
globale personalizzata. Fare clic sul pulsante cartella in fondo, ed esplorare la cartella del percorso data.

Selezionare il file sym-lib-table .

La posizione dei file tabella librerie predefinite dipende dal sistema operativo e può variare in base alla
posizione di installazione. In basso le posizioni predefinite per ogni sistema operativo:

Windows: C:\Program Files\KiCad\9.0\share\kicad\template\

Linux: /usr/share/kicad/template/

macOS: /Applications/KiCad/KiCad.app/Contents/SharedSupport/template/

Basi dell’editor degli schemi elettrici
Per fare pan in giro per lo schema, fare clic e trascinare con il pulsante centrale o quello destro del mouse.
Ingrandire e rimpicciolire con la rotellina or  e . Gli utenti dei portatili potrebbero trovare comodo
cambiare i controlli del mouse per accordarli meglio con il touchpad; i controlli del mouse sono configurabili
in Preferenze → Preferenze…  → Mouse e Touchpad.

F1 F2
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NOTE Su macOS, la finestra delle preferenze è nel menu KiCad, non nel menu delle Preferenze.

Per impostazione predefinita, KiCad abilita un’impostazione del mouse denominata Centra e sposta il
puntatore con lo zoom. Quando questa funzione è abilitata, il cursore del mouse si sposta automaticamente
al centro dello schermo quando l’utente esegue lo zoom avanti o indietro. Ciò mantiene la regione
ingrandita sempre centrata. Questa funzione può sembrare un po' strana all’inizio, ma molti utenti la

trovano utile una volta abituati. Provare a ingrandire e rimpicciolire con il puntatore del mouse in diverse
aree dell’area di lavoro. Se il comportamento dello zoom predefinito risulta scomodo, disabilitare la
funzione nelle preferenze Mouse e Touchpad.

La barra degli strumenti sul lato sinistro dell’editor degli schemi contiene le impostazioni di visualizzazione
di base. La barra degli strumenti sul lato destro dello schermo contiene gli strumenti per modificare lo

schema.

Alla maggior parte degli strumenti in KiCad sono assegnati comandi da tastiera predefiniti o possono essere
assegnati comandi da tastiera personalizzati. Per visualizzare tutti i comandi da tastiera, andare su Aiuto →
Elenco tasti… . I comandi da tastiera possono essere modificati nel pannello Comandi da tastiera della

finestra delle Preferenze.

Impostazione foglio schema
Prima di disegnare qualcosa nello schema, impostare il foglio dello schema stesso. Fare clic su File →
Impostazioni pagina. Assegnare allo schema un titolo e una data e, se si vuole, modificare il formato della
carta.
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Aggiunta di simboli allo schema
Iniziare a creare il circuito aggiungendo alcuni simboli allo schema. Aprire la finestra di dialogo Scegliere

simbolo facendo clic sul pulsante Aggiungi simboli  sul lato destro della finestra o premendo .

Questa azione attiverà la finestra di dialogo per l’impostazione della tabella librerie di impronte se questa

non è già stata attivata. Questa finestra di dialogo è equivalente alla finestra di dialogo di impostazione della
tabella librerie di simboli spiegata in precedenza, ma per le impronte anziché per i simboli.

Di nuovo, selezionare l’opzione predefinita: Copia la tabella librerie impronta globale predefinita
(raccomandato). Se questa opzione è disabilitata, selezionare la seconda opzione, Copia tabella librerie
impronta globale personalizzata. Fare clic sul pulsante cartella in basso e passare la posizione indicata le
istruzioni di configurazione della tabella della libreria dei simboli. Selezionare il file fp-lib-table  e fare
clic su OK.

La finestra di dialogo Scegli simbolo elenca le librerie di simboli disponibili e i simboli dei componenti in

esse contenuti. I dispositivi di base come componenti passivi, diodi e altri simboli generici si trovano nella
libreria Device . Dispositivi specifici, come un tipo particolare di LED, si trovano nelle altre librerie.

Scorrere verso il basso fino alla libreria "Device", espanderla e selezionare il simbolo "LED". Fare clic su OK e
fare nuovamente clic per posizionare il simbolo nello schema.

A
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Quindi, aggiungere una resistenza di limitazione di corrente. Tornare al selettore dei simboli, ma questa
volta provare a cercare una resistenza inserendo "R" nella casella del filtro in alto. Di nuovo, si trova nella
libreria Device . Il dispositivo R  è un simbolo di resistenza rettangolare in stile IEC. Un simbolo R_US  è

disponibile anche per gli utenti che preferiscono il simbolo a zigzag in stile ANSI. Selezionare un simbolo di
resistenza e aggiungerlo allo schema.

Infine, aggiungere una batteria per alimentare il LED. La libreria Device  ha il simbolo appropriato

Battery_Cell .



13

Selezione e spostamento oggetti
Next, position the symbols correctly relative to each other, as shown in the screenshot. You will do this by

selecting each symbol, then moving and rotating it.

In KiCad, objects are selected by clicking on them while the selection tool is active. The selection tool is the

default tool when no other tool is active, so you can enter the selection tool by quitting any active tool (

) or by clicking the  button in the right toolbar.

Ulteriori oggetti possono essere aggiunti alla selezione con +clic, o rimossi con + +clic
(MacOS: + +clic).È possibile commutare lo stato della selezione di un oggetto con +clic

(macOS: +clic).

Esc

Maiusc Ctrl Maiusc

Cmd Maiusc Ctrl

Cmd
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È anche possibile trascinare la selezione; trascinando da sinistra a destra si selezionano gli oggetti che sono
interamente racchiusi dalla casella di selezione, mentre trascinando da destra a sinistra si selezionano anche

gli oggetti che sono parzialmente racchiusi dalla casella di selezione. , +  ( + ), e 
 ( ) possono essere utilizzati anche con la selezione trascinata, rispettivamente per aggiungere,

sottrarre o commutare dalla selezione.

Si noti che è possibile selezionare un intero simbolo (facendo clic sulla forma del simbolo stesso) o

selezionare un campo di testo nel simbolo senza selezionare il resto del simbolo (facendo clic sul testo).
Quando viene selezionato solo un campo di testo, qualsiasi azione eseguita agirà solo sul testo selezionato e
non sul resto del simbolo.

Gli oggetti selezionati vengono spostati premendo  e ruotati premendo . Il tasto comando 

(trascinamento) può essere utilizzato anche per spostare gli oggetti. Per lo spostamento di simboli non
collegati,  e  si comportano in modo identico, ma per i simboli con fili collegati,  sposta il simbolo e
mantiene i fili collegati, mentre  sposta il simbolo e lascia i fili indietro. Gli oggetti selezionati possono
essere cancellati con il tasto .

Cablaggio dello schema
The symbol pins all have small circles on them, indicating that they are not connected. Fix that by drawing

wires between symbol pins as shown in the screenshot. Click the Add a Wire button  on the right-hand

toolbar or use the  hotkey. Click and release to start drawing a wire, and finish drawing the wire by
clicking on a symbol pin or double clicking anywhere. Pressing Escape will cancel drawing the wire.

Un altro metodo conveniente per disegnare i fili è passare con il mouse su un pin scollegato. Il cursore del
mouse cambierà per indicare che è possibile tracciare un filo a partire da quella posizione. Cliccando sul pin
inizierà quindi a disegnare un filo automaticamente.

Maiusc Ctrl Maiusc Cmd Maiusc

Ctrl Cmd

M R G

G M G

M

Canc
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Quindi, aggiungere i simboli di potenza e terra allo schema. Sebbene non siano strettamente necessari in uno
schema così semplice, facilitano la comprensione di schemi di grandi dimensioni.

Nella libreria dei simboli Power  sono disponibili numerosi simboli di potenza / alimentazione e terra.

Tuttavia, esiste una scorciatoia per aggiungere questi simboli: fare clic sul pulsante Aggiungi un simbolo di
potenza  o usare il tasto comando . Verrà visualizzata la finestra di dialogo Scegli un simbolo, ma

verranno visualizzate solo le librerie di simboli che contengono i simboli di potenza e alimentazione.

Aggiungere un simbolo VCC e un simbolo GND e quindi collegarli al circuito con dei fili.

Infine, aggiungere un’etichetta al filo tra il LED e la resistenza. Anche in questo caso, questo potrebbe non
essere necessario in un circuito semplice, ma è buona norma etichettare le reti importanti. Fare clic sul

pulsante Aggiungi etichetta  nella barra degli strumenti a destra ( ), digitare un nome per l’etichetta

( led ) e posizionare l’etichetta nello schema in modo che il punto di attacco quadrato si sovrapponga al filo.
Ruotare e allineare l’etichetta se necessario.

P

L
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Si noti che le etichette e le porte di alimentazione con lo stesso nome vengono considerate collegate assieme.
Un’altra porta di alimentazione GND o un cavo etichettato led  in questo foglio di schema verrebbe
cortocircuitato con quello esistente, anche senza fili che li collegano visivamente.

Annotazione, proprietà simbolo, e impronte

Annotazione
A ciascun simbolo occorre assegnare un riferimento univoco. Questo processo è noto anche come

annotazione.

By default, symbols are automatically annotated when they are added to the schematic. Automatic

annotation can be enabled or disabled using the  button in the left toolbar.

Anche se non è necessario per questa guida, i simboli possono essere annotati o riannotati manualmente

utilizzando il pulsante Compila i riferimenti dei simboli nello schema ( ) nella barra degli strumenti in

alto.
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Proprietà del simbolo
Quindi, inserire i valori per ciascun componente. Selezionare il LED, fare clic con il pulsante destro del
mouse e selezionare Proprietà…  ( ). Questo progetto utilizzerà un LED rosso, quindi cambiare il campo
Valore  in rosso . In un progetto reale, potrebbe essere meglio scrivere qui il numero di parte del
produttore del LED. Si noti che è possibile modificare i riferimenti individualmente nelle proprietà di

ciascun simbolo.

Questo progetto userà una batteria a bottone al litio da 3 V, quindi cambiare il campo Valore  di BT1  in 3 ̀ .

Cambiare il valore della resistenza in ̀ 1k .

Assegnamento impronte
Infine, assegnare un’impronta a ciascun componente. Ciò definirà come ogni componente si collegherà al

C.S.. Alcuni simboli vengono forniti con impronte preassegnate, ma per molti componenti ci sono più
impronte possibili, quindi l’utente dovrà selezionare quella appropriata.

Esistono diversi modi per assegnare le impronte; un modo comodo è usare lo strumento di assegnazione

impronte facendo clic sul pulsante  nella barra degli strumenti in alto.

Il riquadro sinistro di questa finestra elenca le librerie di impronte disponibili. Il riquadro centrale mostra i

simboli nello schema. A tutti questi simboli verranno assegnate delle impronte. Il riquadro di destra mostra
le impronte impostabili per il simbolo selezionato nel riquadro centrale. Per assegnare un’impronta a un
simbolo, selezionare il simbolo nel riquadro centrale e fare doppio clic sull’impronta desiderata nel
riquadro di destra. Si può ottenere un’anteprima dell’impronta facendo clic con il pulsante destro del mouse

su un’impronta e selezionando Visualizza impronta selezionata.

Molte impronte sono incluse in KiCad, quindi lo strumento di assegnazione delle impronte offre diversi
modi per filtrare le impronte che non sono rilevanti per il simbolo in questione.

Il pulsante più a sinistra  attiva i filtri che possono essere definiti in ogni simbolo. Ad esempio, un

simbolo opamp potrebbe definire filtri che mostrano solo impronte SOIC e DIP. A volte quei filtri
predefiniti mancano o sono troppo restrittivi, quindi può essere utile disattivare questo filtro in alcune
situazioni.

E
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Il pulsante centrale  filtra in base al conteggio dei pin, in modo che vengano mostrate solo le

impronte di 8 pad per i simboli a 8 pin. Questo filtro è quasi sempre utile.

Il pulsante destro  filtra in base alla libreria selezionata. Le librerie sono selezionate nel riquadro di

sinistra; le impronte non nella libreria selezionata verranno filtrate. Questo filtro è utile purché sia noto
quale libreria contiene l’impronta corretta. Spesso è meglio usare questo filtro oppure i filtri simbolo, ma

non entrambi.

La casella di testo filtra le impronte che non corrispondono al testo nella casella. Questo filtro è

disabilitato quando la casella è vuota.

Using the filters, find each of the footprints shown in the central column in the screenshot above. The

footprints for each symbol are also listed in the table below. Assign each footprint to a symbol by selecting
the symbol in the central column and then double clicking the appropriate footprint in the right column.
Once all of the footprints have been assigned, click OK.

Symbol Reference Footprint to assign

BT1 Battery:BatteryHolder_Keystone_1058_1x2032

D1 LED_THT:LED_D5.0mm

R1 Resistor_THT:R_Axial_DIN0309_L9.0mm_D3.2mm_P12.70mm_Horizontal

Ci sono altri modi per assegnare le impronte; un modo è attraverso la finestra delle proprietà del simbolo.
Per ulteriori informazioni sull’assegnazione delle impronte, consultare il manuale.

Controllo regole elettriche
L’ultima cosa da fare nello schema è controllare gli errori di natura elettrica. Il controllo delle regole

elettriche (ERC) di KiCad non può garantire che il progetto nello schema funzioni, ma può verificare che non
sussistano banali problemi di connessione come pin scollegati, uscite di alimentazione in cortocircuito o
ingressi di alimentazione non alimentati. Esso verifica anche la presenza di altri errori come simboli non
annotati e errori di battitura nelle etichette delle connessioni. Per visualizzare l’elenco completo delle regole

elettriche e regolarne l’importanza, andare su File→Impostazioni dello schema…  → Regole elettriche →
Importanza violazioni. È sempre una buona idea avviare un controllo regole elettriche prima di avviare la
stesura del circuito stampato.

Eseguire un controllo delle regole elettriche facendo clic sul pulsante ERC  nella barra degli strumenti in

alto e quindi facendo clic su Esegui ERC.

Anche in questo semplice schema, KiCad ha riscontrato due potenziali errori. Gli errori sono elencati nella
finestra ERC e le frecce indicano le posizioni delle violazioni nello schema. Selezionando una violazione
nella finestra ERC si evidenzia la freccia corrispondente.

file:///src/build/src/getting_started_in_kicad/eeschema/eeschema.html#assigning-footprints
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Le violazioni si possono ignorare (per l’esecuzione ERC corrente) o escludere (da tutte le future esecuzioni

ERC) facendo clic con il pulsante destro del mouse su ciascun messaggio di errore. Tuttavia, di solito vale la
pena affrontare le violazioni, anche se non sono veri e propri errori di progettazione, al fine di ottenere un
rapporto ERC pulito ed evitare di farsi sfuggire dei problemi reali.

In questo caso, KiCad segnala "Pin di potenza in ingresso non pilotato da alcun pin di potenza in uscita" per

entrambe le reti VCC  e GND . Questo è un classico errore ERC di KiCad. I simboli porta di potenza sono
impostati per richiedere un pin di potenza di uscita, come l’uscita di un regolatore di tensione, sulla stessa
rete; altrimenti KiCad potrebbe pensare  che il collegamento non sia pilotato. Per un essere umano, è ovvio

che VCC  e GND  sono pilotati dalla batteria, ma è necessario indicarlo esplicitamente nello schema.
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C’è uno speciale simbolo PWR_FLAG  nella libreria dei simboli Power  che viene usato per risolvere questo
problema indicando a KiCad che i collegamenti sono effettivamente pilotati. Aggiungere questo simbolo alle
net VCC  e GND  ed esegui nuovamente il controllo. Quando l’ERC passerà senza alcuna violazione, lo schema

sarà completo.

Distinta di base
Un ultimo passaggio facoltativo consiste nel generare una distinta base che elenca tutti i componenti
utilizzati nel progetto. Fare clic su Strumenti → Genera distinta materiali… .
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KiCad has a GUI for BOM export. You can configure which symbol metadata will be exported, and how the
symbols are grouped, in the Edit tab, and configure the output format in the Export tab.

Per ora, le impostazioni predefinite dovrebbero andare bene, ma è possibile osservare una vista grezza di
ciò che verrà esportato nel riquadro di anteprima. Specificare un file di uscita nella scheda Esporta, e

premere il pulsante Esporta.

La DIBA dovrebbe assomigliare all’immagine di seguito se aperta in un programma di gestione dei fogli
elettronici.
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Tutorial parte 3: il circuito stampato
Con lo schema completato, tornare alla finestra del progetto e aprire l’editor del C.S. facendo clic sul
pulsante Editor C.S. o aprendo il file dello stampato.

Funzioni di base di modifica del circuito stampato
La navigazione nell’editor di circuiti stampati è la stessa dell’editor schemi elettrici: il pan si fa trascinando
con il pulsante centrale del mouse o con il pulsante destro del mouse e per ingrandire invece con la rotellina

del mouse o tramite / .

La parte principale dell’editor dei circuiti stampati. è la zona disegnabile al centro su cui viene steso il
progetto della scheda. La barra degli strumenti sul lato sinistro ha varie opzioni di visualizzazione per la
scheda, incluse le unità di misura e le modalità di visualizzazione bordo/pieno per tracce, via, pad e zone. La

barra degli strumenti a destra dell’area di disegno contiene gli strumenti per la progettazione dello
stampato.

NOTE

Alcuni pulsanti sulla barra degli strumenti a destra hanno un piccolo triangolo nell’angolo

in basso a destra . Il triangolo indica che il pulsante ha una tavolozza espandibile

contenente diversi strumenti correlati, ad esempio diversi tipi di dimensioni. Per
selezionare uno strumento alternativo, fare clic e tenere premuto il pulsante finché non
viene visualizzata la tavolozza, quindi fare clic sullo strumento alternativo. Un altro
modo per utilizzare le tavolozze è fare clic sul pulsante e trascinare verso sinistra finché
non viene visualizzata la tavolozza, quindi rilasciare il pulsante del mouse quando lo
strumento desiderato viene evidenziato.

All’estrema destra c’è il pannello Aspetto e il filtro di selezione. Il pannello Aspetto viene utilizzato per
modificare la visibilità, i colori e l’opacità di strati, oggetti e collegamenti dello stampato. Lo strato attivo
viene modificato facendo clic sul nome dello strato.

Sotto il pannello Aspetto c’è il filtro di selezione, che abilita e disabilita la selezione di vari tipi di oggetti
dello stampato. Ciò è utile per selezionare elementi specifici in un layout affollato.

Configurazione e impilamento della scheda
Prima di iniziare la progettazione dello stampato, impostare le dimensioni pagina e aggiungere informazioni
al cartiglio. Fare clic su File → Impostazioni pagina… , quindi scegliere un formato carta appropriato e

inserire data, revisione e titolo.

F1 F2
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Quindi, andare su File → Impostazione scheda…  per definire come verrà prodotto il circuito stampato. Le
impostazioni più importanti sono lo stackup, ovvero quali strati di rame e dielettrico avrà il PCB (e i loro
spessori) e le regole di progettazione, ad es. dimensioni e spaziatura per tracce e via.

Per impostare lo stackup, aprire la pagina Stackup scheda → Stackup fisico della finestra Impostazione

scheda. Per questa guida, lasciare il numero di strati di rame a 2, ma progetti chiaramente più complessi
potrebbero richiedere un numero maggiore di strati.
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Successivamente, andare alla pagina Regole di progettazione → Vincoli. Le impostazioni in questa pagina
specificano le regole di progettazione prioritarie per tutto il progetto della scheda. Ai fini di questa guida, le

impostazioni predefinite vanno bene. Tuttavia, per un progetto reale, queste dovrebbero essere impostate
in base alle capacità e caratteristiche del fabbricante di circuiti stampati in modo che il progetto del circuito
stampato sia realizzabile.
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Finally, open the Design Rules → Net Classes page. A net class is a set of design rules associated with a
specific group of nets. This page lists the design rules for each net class in the design and allows assigning

nets to each net class (nets can also be assigned to net classes in the schematic editor).

Larghezze e spaziature piste possono essere gestite manualmente dal progettista durante la stesura del C.S.,
ma l’uso delle netclass è consigliato perché forniscono un modo automatico per gestire e controllare le

regole di progettazione.

In this design, no net classes are specified, so all nets will belong to the Default  net class. The default design
rules for this net class are acceptable for this project, but other designs may have multiple net classes, each
with different design rules. For example a board might have a High Current  netclass with wide tracks, or a

50 ohm  netclass with specific width and clearance rules for 50 ohm controlled-impedance tracks.

Importazione cambiamenti dallo schema
Lo schema è completo, ma non ci sono ancora componenti nell layout. Per importare i dati di progettazione
dallo schema nel C.S., fare clic su Strumenti → Aggiorna il C.S. dallo schema…  o premere . C’è anche un

pulsante  nella barra strumenti in alto.

Leggere i messaggi nella finestra Modifiche da applicare, che diranno che i tre componenti nello schema

verranno aggiunti alla scheda. Fare clic su Aggiorna C.S., Chiudi e fare clic sull’area di disegno per
posizionare le tre impronte. La posizione di ciascuna impronta rispetto alle altre verrà modificata in seguito.

F8
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In KiCad, l’aggiornamento del C.S. con le modifiche allo schema è un processo manuale: il progettista decide
quando è opportuno aggiornare il C.S. con le modifiche allo schema. Ogni volta che lo schema viene

modificato, il progettista deve utilizzare lo strumento Aggiorna il C.S. dallo schema per mantenere lo
schema e il layout sincronizzati.

Disegnare il bordo scheda
Ora i tre componenti sono stati posizionati, ma la scheda stessa non è stata definita. La scheda viene definita
disegnando il bordo scheda sul livello Edge.Cuts .

Spesso è utile disegnare il borso scheda con una griglia grossolana, rendendo facile ottenere numeri interi
per le dimensioni della scheda. Passare a una griglia grossolana selezionando 1mm nel menu a discesa
Griglia sopra la zona di lavoro.

To draw on the Edge.Cuts  layer, click Edge.Cuts in the Layers tab of the Appearance panel at right. Choose

the rectangle tool  in the right toolbar, click on the canvas to place the first corner, then click again to
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place the opposite corner so that the rectangle roughly surrounds the three footprints. The other graphic

tools (line , arc , circle , polygon , bezier , or a combination of them) could also be used to

define the board outline; the only requirement is that the outline is a single closed shape that doesn’t

intersect itself.

Piazzamento impronte
Il passaggio successivo nel processo di layout è disporre le impronte sulla scheda. In generale, ci sono
diverse considerazioni per il posizionamento delle impronte:

Alcune impronte possono avere requisiti esatti per la loro posizione, come connettori, indicatori o

pulsanti e interruttori.

Potrebbe essere necessario posizionare alcuni componenti in base a considerazioni elettriche. I
condensatori filtro devono essere vicini ai pin di alimentazione dell’IC associato e i componenti analogici

sensibili devono essere lontani da interferenze digitali.

Almost all components have a "Courtyard" (or two if both Front and Back are defined). Generally

courtyards should not intersect.

Altrimenti i componenti dovrebbero essere posizionati per facilitare lo sbroglio. I componenti collegati

dovrebbero generalmente essere vicini tra loro e disposti in modo da ridurre al minimo la complessità
dello sbroglio. La ratsnest (le linee sottili che indicano le connessioni tra le piazzole) è utile per
determinare come posizionare al meglio le impronte rispetto ad altre impronte.

Ai fini di questa guida, l’unico obiettivo del posizionamento è rendere il processo di sbroglio il più semplice
possibile.

Iniziare spostando il supporto della batteria BT1  sul lato posteriore della scheda. Fare clic per selezionarlo,
quindi premere  per spostarlo. Premere  per girarlo sul lato opposto; ora appare specchiato e le sueM F
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piazzole sono cambiate da rosso a blu.

Tutti gli strati del C.S. sono visualizzati dal lato anteriore della scheda. Le impronte sul fondo della scheda

sono quindi capovolte e appaiono specchiate.

Ogni strato della scheda ha un colore univoco, mostrato dai campioni di colore nella scheda Livelli del
pannello Aspetto. Nello schema colori predefinito, gli elementi sullo strato F.Cu  (rame anteriore) sono
rossi, mentre gli elementi sullo strato B.Cu  (rame posteriore) sono blu.

Ora posizionare gli altri due componenti. Uno alla volta, selezionare ciascun componente, quindi spostarlo e
ruotarlo con  e . Osservare le linee dei collegamenti (ratsnest) tra le piazzole per scegliere la
disposizione più semplice dei componenti; una buona disposizione lascerà le linee intricate. La schermata
sotto mostra una possibile disposizione.

M R
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Sbroglio piste
With the components in place, it’s time to connect the pads with copper tracks.

The first track will be drawn on the front of the board, so change the active layer to F.Cu  in the Layers tab
of the Appearance panel.

Click Route Tracks  in the right-hand toolbar or press . Click on the led  pad of D1  and release the

mouse button. The ratsnest line indicates there is an unrouted connection to the led  pad of R1 , so click on
that pad to draw a track connecting the two pads. Clicking on the second pad completes the track. The

ratsnest line between the led  pins is no longer drawn because the connection has been made in copper.

X
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Now draw a track between the GND  pads of BT1  and D1 , starting with the BT1  pad on the back of the
board. Notice that the active layer automatically changed to B.Cu  after clicking on the BT1  pad. Click on the

D1  pad to finish the track.

While BT1  has surface mount pads that are only on the bottom of the board, D1  has through hole pads that
can connect to tracks on both the front and back. Through hole pads are one way to make a connection
between multiple layers. In this case, D1  is a component on the front side of the board, but its through hole

pads are used to connect to a track on the back of the board.

Un altro modo per stabilire una connessione tra strati è tramite un via. Iniziare lo sbroglio dalla piazzola VC
di BT1  sul retro della scheda. Premere  e fare clic a metà strada tra BT  e R1  per inserire un via,

operazione che commuta anche lo strato attivo su F.C . Completare la pista sul lato superiore della scheda
facendo clic sulla piazzola VCC  di R1 .

V
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A questo punto, tutte le connessioni (net) sono sbrogliate. Ciò può essere confermato guardando la
schermata di stato in basso a sinistra della finestra, dove il numero di connessioni non sbrogliate è indicato
come 0.

Piazzamento zone rame
Copper zones are regions of copper with an associated net. Zones automatically connect to copper objects

belonging to the same net and avoid objects belonging to other nets. Zones are often used for ground and
power connections because they provide a lower impedance connection than tracks.

Aggiungere una zona GND  sul retro scheda passando allo strato di rame inferiore e facendo clic sul pulsante

Aggiungi una zona piena  nella barra degli strumenti di destra. Fare clic sul C.S per posizionare il primo

vertice della zona.

Nella finestra di dialogo Proprietà zona rame che appare, selezionare il collegamento GND  e assicurarsi che
sia selezionato lo strato B.Cu . Fare clic su OK, quindi fare clic per posizionare gli altri tre vertici della zona.
Fare doppio clic quando si posiziona l’ultimo vertice per completare la zona.
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The zone outline is displayed on the canvas, but the zone is not yet filled — there is no copper in the zone

area, and therefore the zone is not making any electrical connections. Fill the zone with Edit → Fill All
Zones ( ). Copper has been added to the zone, but it doesn’t connect to the VCC  or led  pads and tracks,
and is clipped by the board edge. It overlaps with the GND  track drawn earlier, and it connects to the GND
pads through thin tracks. These are thermal reliefs, which make the pads easier to solder. Thermal reliefs

and other zone settings can be modified in the zone properties dialog.

B
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In KiCad, le zone non vengono riempite automaticamente quando vengono disegnate o modificate per la

prima volta, o quando le impronte al loro interno vengono spostate. Le zone vengono riempite
riempiendole manualmente e quando si eseguono i controlli regole elettriche. Assicurarsi che i riempimenti
delle zone siano aggiornati prima di generare file di fabbricazione.

A volte le zone riempite possono rendere difficile vedere altri oggetti in una scheda affollata. Le zone

possono venire nascoste a parte i confini tramite il pulsante Mostra solo i confini delle zone  sulla

barra degli strumenti a sinistra. Le zone mantengono il loro stato riempito quando vengono mostrati solo i
contorni: nascondere il riempimento di una zona non equivale a svuotarla.

Le zone possono anche essere rese trasparenti utilizzando il pannello Aspetto e i livelli inattivi possono

anch’essi essere nascosti o oscurati utilizzando le Opzioni di visualizzazione dei livelli nel pannello
Aspetto.

Regole di progettazione
Design Rule Checking is the layout equivalent of Electrical Rule Checking for the schematic. DRC looks for
design mistakes like mismatches between the schematic and layout, copper regions that have insufficient

clearance or are shorted together, and tracks that do not connect to anything. You can also write custom DRC
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rules. To view the full list of design rules that are checked and to adjust their severity, go to File → Board
Setup…  → Design Rules → Violation Severity. Running DRC and fixing all errors is strongly advised before

generating fabrication outputs.

Eseguire un controllo DRC con Ispeziona → Verifica regole di progettazione o utilizzare il pulsante 

nella barra degli strumenti in alto. Fare clic su Esegui DRC. Una volta completati i controlli, non dovrebbero
essere segnalati errori o avvisi. Chiudere la finestra DRC.

Now intentionally cause a DRC error by moving the resistor footprint to overlap the filled area of the zone.

Use  (Drag) to move the resistor footprint slightly while keeping the tracks attached to its pads. This
creates a clearance violation because the VCC  and led  pads of the resistor are shorted to the GND  zone fill.
Ordinarily this would be fixed by refilling the zone, but don’t refill the zone yet.

Run DRC again, but make sure to uncheck the Refill all zones before performing DRC checkbox. DRC
reports 6 violations: for each pad of R1 , there is a clearance violation between the pad and the zone,
another clearance violation between the pad’s through hole and the zone, and a third violation where the

pad’s solder mask opening exposes the copper of two different nets (the GND  fill and the track connected to
the pad). Arrows point to each violation in the canvas. Clicking on each violation message zooms in on the
respective violation.

D
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Chiudere la finestra di dialogo DRC, premere  per riempire la zona e rieseguire il DRC. In alternativa,

selezionare la casella di controllo Riempire tutte le zone prima di eseguire il DRC ed eseguire nuovamente
il DRC. Tutte le violazioni sono state corrette.

Visualizzatore 3D
KiCad offre un visualizzatore 3D utile per ispezionare il C.S. . Aprire il visualizzatore 3D con Visualizza →
Visualizzatore 3D. Effettuare la panoramica trascinando con il pulsante centrale del mouse e orbitare

trascinando con il pulsante sinistro del mouse. Orbitare attorno al circuito stampato per vedere il LED e il
resistore in alto e il supporto della batteria in basso.

È disponibile una modalità raytracing, che è più lenta ma offre un rendering più accurato. Passare alla
modalità raytracing con Preferenze → Raytracing.

B
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Molte delle impronte nella libreria di KiCad sono dotate di modelli 3D, incluse tutte le impronte utilizzate in
questa guida. Alcune impronte non vengono fornite con modelli 3D, ma gli utenti possono aggiungerne di

propri.

File per la fabbricazione
Una volta completata la progettazione della scheda, il passaggio finale consiste nel generare i file necessari
per la fabbricazione in modo che la scheda possa essere prodotta.

Aprire la finestra di dialogo Traccia, tramite File → Traccia… . Questa finestra di dialogo può tracciare il
progetto in diversi formati, ma Gerber è solitamente il formato giusto per l’ordine di un C.S. da un
produttore.

Specificare una cartella di uscita in modo che i file tracciati vengano raccolti in essa. Altrimenti, le

impostazioni predefinite vanno bene, ma assicurarsi che tutti i livelli necessari siano selezionati: includere i
livelli di rame ( *.Cu ), il contorno della scheda ( Edge.Cuts ), la maschera di saldatura ( *.Mask ) e serigrafia
( *.Silkscreen ). Gli strati della pastasalda ( *.Paste ) sono utili per produrre gli stencil per la pastasalda. Gli
strati adesivi ( *.Adhesive ) sono necessari solo se alcuni componenti verranno incollati alla scheda durante

l’assemblaggio. Altri strati possono essere utili da tracciare, ma in genere non sono necessari per la
fabbricazione di circuiti stampati.
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Fare clic su Traccia per generare i file Gerber. Fare inoltre clic su Genera file forature…  e quindi su Genera
file forature per creare file specificando la posizione di tutti i fori che verranno praticati nella scheda.

Infine, chiuderela finestra di dialogo Traccia. Il progetto è finito.



39
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Tutorial parte 4: simboli e impronte
personalizzati
Il circuito può essere migliorato aggiungendo un interruttore per accendere e spegnere il LED. Il processo
per aggiungere questo interruttore richiederà la creazione di una nuova libreria di simboli e impronte, il

disegno di un simbolo di interruttore e la creazione di un’impronta per l’interruttore.

L’interruttore specifico che verrà utilizzato in questa guida è NKK M2011S3A1W03, un interruttore a levetta
SPST. Potrebbero essere utilizzati molti altri interruttori, ma potrebbe essere necessario modificare la

numerazione dei pin e l’ampiezza dell’ingombro.

Nozioni base su librerie e tabella librerie
Simboli e impronte sono organizzati in librerie. Una libreria può contenere simboli o impronte, ma non
entrambi.

KiCad tiene traccia delle librerie di simboli e delle librerie di impronte dell’utente rispettivamente nella

tabella delle librerie di simboli e nella tabella delle librerie di impronte. Ogni tabella delle librerie è un
elenco di nomi di librerie e la posizione in cui ciascuna libreria esiste sul disco.

Oltre alle tabelle globali delle librerie di simboli e impronte, sono disponibili anche le tabelle delle librerie
specifiche del progetto per simboli e impronte. I simboli e le impronte aggiunti alle tabelle globali sono

disponibili in tutti i progetti, mentre i simboli e le impronte aggiunti alle tabelle specifiche del progetto sono
disponibili solo per quel progetto specifico. Gli utenti possono aggiungere le proprie librerie alle tabelle
delle librerie globali o alle tabelle specifiche del progetto.

Le tabelle delle librerie di simboli possono essere visualizzate o modificate con Preferenze → Gestisci
librerie di simboli…  nelle finestre dell’Editor degli schemi elettrici o dell’Editor dei simboli. Le tabelle delle
librerie di impronte possono essere visualizzate o modificate con Preferenze → Gestisci librerie di
impronte…  nell’editor dei circuiti stampati o nell’editor delle impronte. È possibile accedere a entrambe le
tabelle di librerie anche dalla finestra di gestione del progetto.

https://www.nkkswitches.com/pdf/MtogglesBushing.pdf
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Spesso i percorsi delle librerie sono definiti con variabili di sostituzione del percorso. Ciò consente a un
utente di spostare tutte le proprie librerie in una nuova posizione senza modificare le tabelle delle librerie.

L’unica cosa che deve essere cambiata è la definizione della variabile in modo che punti alla nuova
posizione. Le variabili di sostituzione del percorso di KiCad vengono modificate con Preferenze →
Configura percorsi…  nella Gestione del progetto o in qualsiasi finestra di editing.

Una utile variabile di sostituzione del percorso è ${KIPRJMOD} . Questa variabile punta sempre alla cartella

del progetto corrente, quindi può essere utilizzata per includere librerie specifiche del progetto archiviate
nella cartella del progetto.

Alla prima esecuzione, KiCad chiede all’utente di impostare la tabella delle librerie di simboli e tabella delle
librerie delle impronte. Per ripetere questa impostazione, eliminare o rinominare i file della tabella librerie

di simboli o della tabella librerie di impronte. Effettuare un backup delle tabelle prima di eliminarle.

La posizione dei file della tabella librerie di simboli e di impronte dipende dal sistema operativo.

Windows: %APPDATA%\kicad\9.0\sym-lib-table  and %APPDATA%\kicad\9.0\fp-lib-table

Linux: ~/.config/kicad/9.0/sym-lib-table  and ~/.config/kicad/9.0/fp-lib-table

macOS: ~/Library/Preferences/kicad/9.0/sym-lib-table  and
~/Library/Preferences/kicad/9.0/fp-lib-table

Creazione nuove librerie globali o di progetto
Il primo passo per disegnare un nuovo simbolo o impronta è scegliere una libreria nella quale
memorizzarlo. Per questa guida, il simbolo e l’impronta dell’interruttore verranno inseriti nelle nuove

librerie specifiche del progetto.

Aprire l’editor dei simboli dal Project Manager. Fare clic su File → Nuova libreria e selezionare Progetto.
Scegliere un nome per la nuova libreria (ad esempio getting-started.kicad_sym ) e salvarla nella cartella
del progetto. La nuova libreria vuota è ora selezionata nel riquadro Librerie a sinistra ed è stata

automaticamente aggiunta alla tabella delle librerie del progetto (controllare la scheda Librerie specifiche
del progetto in Preferenze → Gestisci librerie di simboli… ).

Creazione nuovi simboli
Ora crea il simbolo dell’interruttore nella nuova libreria. Con la libreria getting-started  selezionata nel
riquadro Librerie, fare clic su File → Nuovo simbolo… . Nel campo Nome simbolo, inserire il codice

prodotto: M2011S3A1W03 . I simboli degli interruttori devono avere riferimenti che inizino con SW , quindi
modificare il campo Riferimento predefinito in SW . Tutti gli altri campi possono rimanere quelli
predefiniti.

Nel pannello Librerie, il simbolo M2011S3A1W03  ora appare sotto la libreria getting-started . Nell’area di

disegno, una croce indica il centro dell’impronta ed è stato aggiunto del testo per il riferimento. Per ora,
spostare il testo lontano dal centro dell’impronta per toglierlo di mezzo.

Piedini del simbolo
Start drawing the symbol by adding a pin. This symbol will not have a pin 1, so we will start with a pin

numbered 2. Click the Add a pin button  on the right toolbar. The Pin Properties dialog will appear. Set

the pin properties as follows:
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Pin name: A

Pin number: 2

Electrical type: Passive

Orientation: Right

X Position: -200 mils

Y Position: 0

Click OK, then click on the canvas to place the pin. If the pin moved after clicking OK, it might be necessary

to edit the pin’s properties again (double click the pin, or right click on the pin → Properties… ) to set the
position correctly.

NOTE

Si consiglia vivamente di utilizzare sempre mil (o pollici) nell’editor degli schemi e in
quello dei simboli, in particolare per i pin dei simboli. Mescolare unità imperiali e
metriche darà luogo a pin dei simboli impossibili da collegare correttamente perché non
allineati con fili o altri pin. Le librerie KiCad usano una griglia da 50 mil per i loro pin;
l’utilizzo di un sistema di unità diverso impedirà ai simboli e agli schemi di connettersi
con i simboli incorporati di KiCad. Si noti che, a differenza dell’editor di C.S., le unità nello
schema non hanno alcun significato fisico.

Aggiungere un secondo piedino, ma questa volta senza lo strumento Aggiungi piedino. Invece, premere 
. Un nuovo pin numero 3 viene aggiunto al simbolo, appena sotto il piedino 2.Ins
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TIP

In molti posti in KiCad, la pressione di  ripeterà l’ultima azione. La posizione del
nuovo elemento verrà spostata e la numerazione incrementata automaticamente, se
possibile. Nell’editor del simbolo, ciò può essere usato per piazzare velocemente molti
piedini. Nell’editor degli schemi, può essere usato per piazzare ripetutamente un
componente, o per etichettare i piedini di un grosso componente con etichette numerate. 

 può essere utile, infine, anche nell’editor delle impronte e del circuito stampato.

We want Pin 3 to be on the right side of the switch symbol, so we will edit its properties to change the
location and orientation. Instead of using the Pin Properties dialog, this time we can use the Properties
Panel. This is a docked panel on the left side of the editing canvas that lets you view and edit the properties

of the selected object or objects. To show or hide the Properties Panel, use the  button in the left toolbar.

With pin 3 selected, use the Properties panel to set its properties as follows:

Pin Name: B

Position X: 200 mils

Position Y: 0

Orientation: Left

NOTE The Properties Panel is available in every KiCad editor (Schematic, Board, Symbol, and
Footprint).

Caratteristiche grafiche
Con i piedini piazzati, usare gli strumenti cerchio  e linea  per far assomigliare il simbolo ad un

interruttore SPST. Per realizzare questo passo, può essere utile impostare la griglia ad un valore più fine: clic
destro sull’area di disegno e selezionare una griglia più piccola nel sottomenu Griglia. Dopo aver aggiunto le

forme grafiche, impostare nuovamente la griglia a 50 mils.

WARNING
Le griglie fini sono utili per le grafiche, ma i piedini del simbolo devono essere sempre
piazzati su una griglia di 50 mils (1.27 mm). I piedini non allineati alla griglia da 50 mils
non si connetteranno ai fili nello schema.

Ins

Ins
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Proprietà del simbolo
Ora modificare le proprietà del simbolo con File → Proprietà simbolo, o fare doppio clic sull’area di
disegno. Cambiare il campo Valore a M2011S3A1W03 , e aggiungere spst switch toggle  al campo
Parolechiave per rendere più facile trovare il simbolo con la ricerca. Per questo simbolo, i nomi dei pin non
aggiungono alcuna informazione utile, perciò deselezionare Mostra nomi dei pin per rendere il simbolo

visualmente più semplice.

Dopo aver fatto clic su OK, spostare il testo del campo valore più in basso in modo che non si sovrapponga
alla grafica del simbolo.

Il simbolo ora è completo. Salvarlo e proseguire con la creazione di un’impronta.

Creazione di nuove impronte
Open the Footprint Editor and create a new project-specific footprint library named getting-

started.pretty  (File → New Library… ). As with symbol libraries, the new footprint library is added to the
project library table. With the new library selected in the Libraries pane, create a new footprint (File → New
Footprint… ). Edit the footprint’s properties (  button in the top toolbar) and set the following

properties:

Footprint name: Switch_Toggle_SPST_NKK_M2011S3A1x03

Value: Switch_Toggle_SPST_NKK_M2011S3A1x03

Component type: Through hole

Piazzole impronte
L’interruttore ha due piedini, numerati nella scheda tecnica come 2 e 3 e distanziati di 4,7 mm l’uno dall’altro.
Per facilitare il posizionamento, regolare la griglia in modo che corrisponda alla spaziatura delle piazzole.

Aprire le proprietà della griglia facendo clic destro sul pulsante  nella barra a sinistra e selezionare
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*Modifica griglia… . Aggiungere una nuova griglia con il pulsante del segno più, in basso. Impostare la
nuova dimensione X della griglia a 4.7 mm . Accettare la modifica nella finestra di dialogo, quindi tornare

all’area di lavoro e passare alla nuova griglia nell’elenco a discesa della barra superiore se non è già
selezionata.

By convention, through-hole footprints have pin 1 located at (0,0)  and are oriented with pin 1 in the top
left. The SPST version of this switch does not have pin 1, so the footprint will leave (0,0)  empty and place

pads 2 and 3 at (0, 4.7 mm)  and (0, 9.4 mm) . Note that in KiCad’s default coordinate system, the positive Y-
axis is oriented downwards.

NOTE
The X and Y coordinates of the cursor are displayed in the status bar at the bottom of the
window. You can use this to check the coordinates when you are drawing or placing
something.

Usare lo strumento Aggiungi piazzola  nella barra degli strumenti a destra per posizionare una piazzola

una passo della griglia sotto l’origine, che è (0, 4,7 mm). Premere  per uscire dallo strumento piazzola,
quindi fare doppio clic sulla piazzola per modificarne le proprietà. Modificare il numero della piazzola in 2
e verificare che la posizione sia corretta. I piedini dell’interruttore misurano 1,17 mm x 0,8 mm, il che dà una
diagonale (dimensione massima del piedino) di 1,42 mm. Impostare quindi il diametro del foro su 1,42 mm +

0,2 mm = 1,62 mm  e il diametro della piazzola a 1,62 mm + 2*0,15 mm = 1,92 mm  per fornire un anulare
sufficiente.

Esc
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Now use the Add a pad tool again to place the other pad at (0, 9.4 mm) . Notice that the pad number is
automatically incremented and the properties including pad size and hole size are copied from the previous

pad.

Con entrambi i cuscinetti posizionati, gli anulari appaiono leggermente piccoli. L’interruttore sarà più facile
da saldare e meccanicamente più robusto se gli anelli anulari saranno più grandi. Aumentare lo spessore
dell’anulare da 0,15 mm a 0,3 mm modificando la piazzola 2 e cambiando la dimensione del piazzola a 1,62

mm + 2*0,3 mm = 2,22 mm . Non modificare la dimensione del foro. Tenere presente che il campo della
dimensione della piazzola accetta espressioni matematiche, quindi è possibile inserire direttamente
"1,62+2*0,3" e verrà valutato 2,22 mm.

TIP Molte caselle di testo in KiCad supportano espressioni matematiche, inclusa l’unità
conversioni.

Apportare la stessa modifica all’anulare anche all’altra piazzola. Come scorciatoia, fare clic con il pulsante
destro del mouse sulla piazzola 2, fare clic su Invia proprietà piazzola ad altre piazzole… , quindi fare clic
su Cambia piazzole nell’impronta corrente.

Grafiche impronte
Una buona impronta avrà il contorno del componente disegnato esattamente sullo strato di fabbricazione
( F.Fab ), un contorno leggermente più grande sullo strato serigrafico ( F.Silkscreen ) e un ingombro
( F.Courtyard ) che circonda l’intera impronta per evitare sovrapposizioni con altre impronte.

Switch to the front fabrication layer by clicking F.Fab in the Layers panel at right. The fabrication outline

should precisely match the physical dimensions of the part, which is 7.9 mm wide and 13 mm tall. Use the line
, rectangle , or polygon  tools to draw the outline of the part as shown in the screenshot below.

One way to precisely place the outline is to create a new grid with the correct X and Y spacing, as we did for
the pads. Make sure to uncheck the Linked checkbox in the Grid Settings dialog to allow unequal X and Y

grid spacing. You can then adjust the grid origin by right clicking the  button and selecting Grid Origin… .

Configure the grid spacing and origin as follows:

X grid: 7.9 mm

Y grid: 13 mm

X origin: 7.9 mm / 2 = 3.95 mm

Y origin: 4.7 mm - (13 mm / 2) = -1.8 mm .

The completed fabrication drawing is shown below, with corner coordinates annotated.
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Next, switch to the F.Silkscreen  layer. We want the silkscreen outline to be just outside of the part outline,

so the silkscreen lines will be drawn 0.11 mm to the outside of the lines on the fabrication layer (0.11 mm is
half of the 0.10 mm fab line width, plus half of the 0.12 mm silkscreen line width). The exact coordinates are
shown in the screenshot below, and helpful grid settings are:

Griglia X: 7,9 mm + 2 * 0,11 mm = 8,12 mm

Griglia Y: 13 mm + 2 * 0,11 mm = 13,22 mm

Origine X: 8,12 mm / 2 = 4,06 mm

Origine Y: -1,8 mm - 0,11 mm = -1,91 mm

Finally, select the F.Courtyard  layer. We want the courtyard outline to surround the part with a 0.25 mm
clearance.
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For variety, we can use a different strategy to draw the shape on this layer. Switch to a 1mm grid instead of a
custom grid, and draw a rectangle roughly surrounding the footprint. Select the rectangle and press  to

edit its properties, and enter the corner coordinates of the rectangle directly. The corner coordinates are:

Top left: (-4.2, -2.05)

Bottom right: (4.2, 11.45)

Dopo aver completato i contorni, posizionare il testo come mostrato di seguito. L’impronta è completa.

Convenzioni librerie KiCad
Per mantenere librerie di simboli e impronte di alta qualità, KiCad ha un documento KiCad Library

Conventions, che è un set di linee guida per simboli e impronte. Non è necessario seguire queste convenzioni

E

https://klc.kicad.org/
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per le librerie personali, ma sono un buon punto di partenza. Le impronte e i simboli nella biblioteca
ufficiale devono seguire KLC. KLC è usato come base per i simboli e le impronte presenti in questa guida.

Aggiungere interruttori allo schema
Ora che l’impronta è completa, il simbolo dell’interruttore può essere modificato in modo che per

impostazione predefinita venga utilizzato l’impronta corrispondente.

Tornare all’editor dei simboli e aprire il simbolo dell’interruttore. Modificare le proprietà del simbolo. Fare
clic nel campo Impronta , poi fare clic sull’icona a forma di libro della libreria  che appare. Sfogliare la

libreria delle impronte del progetto e fare doppio clic sull’impronta dell’interruttore. Salvare il simbolo.

Ora l’impronta dell’interruttore è assegnata a questo simbolo per impostazione predefinita; non è
necessario selezionarla manualmente ogni volta che il simbolo viene aggiunto a uno schema.

Aprire lo schema, aggiungere un nuovo simbolo e selezionare il nuovo simbolo dell’interruttore. Allacciarlo
per connettere o sconnettere il LED alla batteria.

Non è necessario scegliere manualmente un’impronta per l’interruttore, perché il simbolo dell’interruttore

specifica già un’impronta. Eseguire l’ERC per assicurarsi che lo schema modificato non violi alcuna regola
elettrica.

https://gitlab.com/kicad/libraries
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Aggiungere l’interruttore alla scheda
Make sure the schematic is saved, then open the Board Editor to add the symbol to the layout. Update the

PCB with the schematic changes using Tools → Update PCB from Schematic…  and place the switch
footprint onto the board as shown. If needed, resize the board outline and copper zone (the copper zone
will unfill if it is resized, but you can re-fill it as necessary with ).B
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La ratsnest mostra le nuove connessioni da sbrogliare. Inoltre, la connessione tra la batteria e la resistenza
deve essere eliminata.

First, delete the unneeded tracks. Select one of the tracks between the battery and the resistor — it doesn’t
matter which. Press  several times to expand the selection to include all the segments between the
battery and resistor. Press  to remove the connection.

Route the new tracks between the battery and the switch, and between the switch and the resistor. Press 

to refill the zones.

Infine, rieseguire un test DRC per assicurarsi che la scheda modificata non violi alcuna regola di
progettazione.

U

Delete

B
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Collegare simboli, impronte, e modelli 3D

Simboli e impronte
Come descritto nella sezione assegnazione dell’impronta, a ogni simbolo nello schema deve essere assegnata
una impronta durante il processo di inserimento dello schema. Il nome dell’impronta assegnata a ogni

simbolo viene memorizzato nel campo Impronta  delle proprietà del simbolo.

I simboli possono specificare un’impronta preselezionata. Le impronte non devono necessariamente essere

assegnate manualmente a tali simboli, poiché un’impronta era già stata scelta durante la creazione del
simbolo. Gli utenti possono sovrascrivere l’impronta preselezionata durante il processo di assegnazione
dell’impronta come di consueto. Definire un’impronta predefinita è una buona idea per i simboli a cui

solitamente o quasi sempre verrà assegnata la stessa impronta, ad esempio un componente che è disponibile
solo per un tipo specifico di package. L’impronta dell’interruttore predefinita era stata impostata come
predefinita per il suo simbolo corrispondente.
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I simboli possono anche specificare filtri impronte, che possono essere utilizzati per nascondere le impronte
incompatibili con il simbolo. Ad esempio, il simbolo 74HC00  ha filtri impronte che determinano la

visualizzazione solo di impronte DIP e SO14 applicabili nello strumento di assegnamento impronte.

I requisiti KLC per filtri impronte contengono alcuni suggerimenti utili per creare dei filtri impronte efficaci.

Impronte e modelli 3D
I modelli 3D per i componenti vengono archiviati in file separati. I nomi file per i modelli 3D dei componenti
vengono salvati nell’impronta. È possibile aggiungere un numero qualsiasi di modelli 3D ad ogni impronta. I
nomi file dei modelli 3D, insieme a scala del modello, rotazione, scostamento e opacità, sono impostati nella

scheda Modelli 3D delle Proprietà dell’impronta.

Sono supportati sia il formato di modelli 3D STEP ( .step ) che VRML ( .wrl ). I file STEP sono utili quando è

richiesta precisione dimensionale, mentre i file VRML possono essere utilizzati per i rendering visivamente

https://klc.kicad.org/symbol/s5/s5.2/
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più accattivanti. Molte impronte nella libreria di KiCad hanno modelli 3D associati; questi modelli sono
forniti sia in formato VRML che STEP. Solo uno dei due modelli deve essere elencato nell’impronta (in

genere viene fornito il nome file VRML). KiCad può sostituire automaticamente la versione STEP quando
esporta un modello 3D della scheda per l’utilizzo nei CAD meccanici.

NOTE

Non tutte le impronte nella libreria di KiCad sono fornite di modelli 3D, ma tutti le
impronte elencano un nome file di modello 3D anche se il modello 3D non esiste. Questo
perché i modelli 3D potrebbero essere aggiunti in un secondo momento senza dover
modificare l’impronta.

FreeCAD insieme a StepUp Workbench sono utili per creare modelli 3D di componenti; sono usati per molti
dei modelli nella libreria di KiCad. StepUp è usato per generare file STEP e VRML con posizionamento,
ridimensionamento e rotazione corretti.

https://www.freecadweb.org/
https://github.com/easyw/kicadStepUpMod/
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Come continuare
Ulteriori risorse di apprendimento
Per maggiori informazioni su come utilizzare KiCad, consultare il manuale.

Altre risorse includono il forum ufficiale degli utenti di KiCad, le chat Discord o IRC e ulteriori risorse di
apprendimento dalla comunità KiCad.

Per scoprire di più sulle possibilità offerte da KiCad, visitare la sezione Made With KiCad del sito web

oppure aprire i progetti demo inclusi in KiCad (File → Apri progetto demo… ).

Aiutaci a migliorare KiCad
Per segnalare un difetto o richiedere una funzionalità, usare Aiuto → Segnala un difetto o aprire una
segnalazione su Gitlab.

Per contribuire allo sviluppo di KiCad, consultare la pagina dei contributi degli sviluppatori. Anche i semplici

utenti possono aiutare contribuendo allo sviluppo delle librerie o della documentazione e traduzione.
Infine, si consideri il supporto finanziariario per mantenere in modo continuo lo sviluppo di KiCad.

https://docs.kicad.org/
https://forum.kicad.info/
https://www.kicad.org/community/chat/
https://www.kicad.org/help/learning-resources/
https://www.kicad.org/made-with-kicad/
https://gitlab.com/kicad/code/kicad/-/issues
https://dev-docs.kicad.org/en/contribute/
https://www.kicad.org/libraries/contribute/
https://www.kicad.org/contribute/docs-team/
https://www.kicad.org/donate/faq/
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